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from BERNINA®
BY SUSAN BECK

Birthdays and anniversaries are always fun because they give us 

reasons to celebrate. This year BERNINA® reaches a special mile-

stone and will be marking it with a yearlong celebration. Seventy-fi ve 

years ago the BERNINA® 

brand was introduced 

when BERNINA® was used 

by the Fritz Gagauf com-

pany on the model 105 

sewing machine in 1932. 

Taken from a mountain 

in the Swiss Alps, the 

name BERNINA has come to symbolize traditional 

Swiss attributes such as quality, precision, reliability, 

innovation and continuity. As a tribute to the 

BERNINA® name, Fritz Gegauf AG has offi cially 

changed its name to BERNINA® International AG and 

redesigned its logo to incorporate the Swiss fl ag.

This issue of Through The Needle is dedicated to looking back at some of the products and projects 

BERNINA® has featured over the last 75 years, and is full of ideas and inspiration for projects featur-

ing today’s BERNINA® sewing machines, embroidery systems, sergers, and software. Look for photos 

from vintage BERNINA® advertisements scattered throughout the pages and don’t miss page 8 where 

we have Sew Retro, an article featuring stitch techniques fi rst published by BERNINA® in the 1950s 

and 1960s but still very doable on today’s machines.

When we look at BERNINA® machines produced over the last 75 years, it is obvious that the choices 

of the home sewer have multiplied exponentially, affording contemporary stitchers a wide array of 

exciting creative options. It’s fun to see how things have changed, as well as to remember all of the 

BERNINA® machines you’ve owned (and may still be using!). Two of the latest BERNINA® innovations 

– the BERNINA® Stitch Regulator and BERNINA® Embroidery Software Version 5 – are featured in 

articles on pages 4 and 10. 

If you’ve been in a creative slump lately, read Nancy Monson’s 

essay, “Back on the Creative Track!” on page 24. Then, 

make the fun Serger Spiral Pillow on page 16 - a great 

project made easy by using the Gathering Foot on 

the serger. Or, try felting, the latest fi ber craze, and 

make the Wool Floral Table Topper (page 30) using 

the Decorative Needle Punch Accessory Set. 

The best way to celebrate 75 years of the 

BERNINA® brand is to use your BERNINA® 

machines to indulge the creative part of your 

personality. So, look through this issue of Through 
The Needle and fi nd something that inspires you to 

have your own party – just you and your BERNINA®!

BERNINA® Model 105 (1932)
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Supplies
•  Nine 5½” squares; 

fabrics used in sample 
are Grandma’s House by 
Mary Lou Weidman for 
Benartex  

•  16” square Warm & 
Natural batting 

•  16” square of backing 
fabric

•  14” Golden Threads 
Paper 

• Polyester organza 
•  OESD Aqua Mesh 

Stabilizer 
•  OESD Ultra Clean ‘n 

Tear Stabilizer 
•  1 silk fl ower head 

(Ranunculus) 
•  Silk fl ower leaves, spines 

removed 
•  5” spring embroidery 

hoop 
• Size 80 Quilting needle 
• Size 90 Jeans needle 
• Size 2.5 Double needle 
•  18” of wire (26 gauge) for 

each free-motion fl ower 
•   2 shades of pink Isacord 

thread 
•  1 green Isacord/YLI 

Variations thread 
•  Additional colors of 

thread as desired
•  YLI Variations thread to 

coordinate 
•  Razzle Dazzle thread to 

coordinate 
• Marking pencil/pen 
• Straight pins 
• Stencil burner 
• Wire snips 
• Second bobbin case 
• Small screwdriver 
• Extra bobbins 
•  BERNINA® Stitch 

Regulator Foot #42
•  Clear Embroidery Foot 

#39/39C
•  Patchwork Foot with 

Guide #57
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T H R O U G H  T H E  N E E D L E

BY MARLIS BENNETT

This small wall quilt is a study in free-motion stitching techniques 
using the Bernina® Stitch Regulator. A mixture of piecing, appliqué, 
thread painting, bobbin play, and quilting, this project can also be 
made using other free-motion presser feet such as Darning Foot #9, 
Freehand Embroidery Foot #24 or Quilting Foot #29/29C.
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BSR Basics
Attach the BERNINA® Stitch Regulator  (BSR), 
lower the feed dog, and thread the machine. 

Lower the Presser Foot Pressure to 1, if needed, 
to allow easier movement of the fabric under the 
foot.

Activate the Needle Stop Down function and 
select the desired Mode: BSR 1 or BSR 2. (see 
following information).

Place fabric under the needle; sink and raise the 
needle to bring the bobbin thread to the top of 
fabric. Take 2-3 stitches to secure the thread, 
then trim the thread ends.

With even speed, move the fabric from front to 
back to get the feel of the machine. Practice a 
variety of motions: zigzag, blocks, u-shapes, 
puzzle pieces, circles, and loops.

Mode Characteristics
Mode 1 / BSR 1 with Foot Control
   •  Needle moves when foot control is pressed.
   •  Enables the use of securing stitch.
   •  Sews like a home machine with regular stitches.

Mode 1 / BSR 1 without Foot Control
  •  Works as an electric needle
  • Unplug the foot control.
  •  Use the Start/Stop button to start the needle moving.
  •  Enables the use of securing stitch.

Mode 2 / BSR 2 with Foot Control
  •  Press foot control and move fabric to make the needle move up and down.
  • Use Securing function to lock stitches
  
Mode 2 / BSR 2 without Foot Control
  • Use the Start/Stop button to start the needle moving.
  •  “Drive” away from the starting point slowly, giving the BSR a chance to 

engage.

  Piecing The Background
    Machine Set Up: Thread machine with 60wt cotton thread, attach #57 foot, insert size 80 quilt needle.

Seam 5½” squares together to form a 9-patch quilt top using ¼” seams. 
Back with batting and backing; baste quilt sandwich together using hand or machine stitches. 

       Double Needle Quilting
  Machine Set Up: Insert Double needle;  wind bobbin 

with YLI Variations thread ½ full - use 2 spool pins: 
one vertical and one horizontal, placing the YLI 
bobbin on the vertical spool pin; insert bobbin with 
60wt cotton Mettler; drop feed dog; attach BSR – 
straight stitch – in desired mode; activate Security 
Program with 2.5 Double needle

       Trace the large, loopy fl ower (pattern A) onto Golden Threads transfer paper 3 times. Trim paper 
apart and place onto 9-patch in desired locations or as shown in photo on page 4. Pin in place. 

Stitch on drawn lines. Take care if fl owers overlap so that the stitching from one fl ower petal does not intersect other petals. Pull beginning 
and ending threads to back and tie off. Deactivate Security Program. 

Change the setting of the machine (see below) and stitch the fl ower centers in a circular motion.

  Machine Set Up: Insert size 90 Jeans Needle, remove YLI bobbin from vertical spool pin, thread needle with YLI thread. 

       Bobbin Play Flowers
  Machine Set Up: Wind 1 bobbin with Razzle Dazzle thread, adjust 

tension on second bobbin case so that Razzle Dazzle fl ows easily, 
insert bobbin into machine, pull up bobbin thread, YLI Variations 
or Mettler 60 weight in needle, increase upper tension by 1 or 
as desired (test). 

Double Needle Tip
Moving the quilt sandwich 
side to side will produce 
straight lines of sewing. It is 
usually desirable to move the 
quilt sandwich front to back, 
as it will produce two distin-
guishable lines of stitching. 
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Trace 2 daisy type fl ower outlines (pattern B) on remaining Golden Threads paper. 
Cut apart and place onto quilt sandwich, on the under side, using photo on page 4 
as a guide. Overlapping previous fl owers adds visual interest to the piece. 

With the wrong side up, pull up thread tail through quilt sandwich, stitch on drawn 
lines. Do not stitch into previously stitched petals. When fi nished, bring all thread 
tails to back and secure. 

Change the settings of the machine (see below) and stitch the fl ower centers in a 
circle, producing satin like stitches. Move fabric sideways to create fl ower highlights. 
 

  Machine Set Up: Select zigzag stitch, YLI Variations in needle, stitch 
width 3.5mm, stitch length 1.5mm 

  Silk Flower Appliqué

Machine Set Up: Straight Stitch, 
2.5mm stitch length, lighter shade 
Isacord pink thread or desired 
color through size 90 Jeans needle, 
Mettler 60wt cotton thread in 
bobbin. Place Ultra Clean N 
Tear Stabilizer behind work – 
if necessary. 

Choose fl ower heads that have no 
glue holding them together. For easier 
stitching, choose fl ower heads whose 

petals form a complete fl ower such as you see in the photo. Remove any spines 
from leaves and insert the leaves behind the fl owers as shown. 

Using the photos as guides, fi ll in fl ower petals with desired color thread. The larger 
petals are stitched in place along their outline fi rst and then fi lled with stitching. The 
largest shapes have a fl ower shape within the petal itself. The smallest shapes have 
no outline and are stitched from the center out. Thread colors have been changed 
as desired. Note: Stitch all centers in a circular motion completely disguising any 
holes left by the fl ower stems. Stitch leaves in place along veins only. 

  Thread Painted 3-D Flowers

Machine Set Up: Wind bobbin 
with dark pink Isacord, thread 
machine with dark pink Isacord 
thread, select zigzag BSR with 
a stitch width of 3mm. 

Trace small pink fl ower (pattern C) 
onto Aqua Mesh Stabilizer. Place the 
stabilizer under a piece of polyester 
organza. Hoop both layers in the center 
of 5” spring hoop.
 

Thread-trace the fl ower on the drawn line with 
several passes of the zigzag stitch. Do not be 
concerned about stitch direction, as you are 
creating a barrier for your stitching. 

Then, using a zigzag stitch (it fi lls faster) and 
moving the hoop sideways, fi ll in the fl ower shape. 
When the fl ower is covered with stitching, select a 
lighter shade of pink and highlight just the center of 
each petal from the center out. If desired, fi ll in the 
center with a pale yellow thread. 

      Machine Set Up: Remove the BSR, 
foot #39, thread needle with desired 
color of thread, raise the feed dog, 
stitch 354, stitch width 2.2mm; button 
sew on stitch. Place hoop in foot area 
before attaching foot #39/39C; thread 
26-gauge wire through opening in foot. 

Using the hoop to turn the fabric, sew the wire 
along the edge of the stitched petals. Make sure 
that the zigzag covers the stitching. Start sewing 
closest to a center along a fl ower petal. 

When fi nished, remove foot, remove hoop from 
machine bed. Snip wire ends. Remove fabric 
from hoop, rinse under running water to remove 
stabilizer. Insert fabric in hoop again, remove 
excess organza using hot stencil burner. The damp 
fl ower will keep the stencil burner from melting the 
threads as easily. 

Attach to quilt top in desired locations using the 
Button Sew-On stitch. 

  Finishing The Quilt
When all stitching is complete, use a rotary cutter, 
mat, and ruler to square the mini-quilt. Finished 
size is approximately 15½” x 15½”. 

Cut bias strips 2½” x 80”, piecing, if needed, to 
make one long strip. Fold the strip in half length-
wise and press. Stitch the folded strip to the edge 
of the quilt (from the front), matching the raw edges 
and mitering the corners.

Wrap the binding to back of the quilt and stitch in 
place by hand or machine.

For more information on several methods of 
binding a quilt, go to www.berninausa.com > 
Online Classes > Sewing Classes > Binding 
Basics.
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Pattern A
Pattern B

Pattern C

Advertisement for the BERNINA® favorit, Model 740 
(1963-1972)



During the 1950s and 60s, BERNINA® published instructions for 
taking decorative stitches to a higher level. The designs pictured 
above are from a series of leafl ets that included directions for 
manipulating decorative stitches into complex embellishments 
for garments, home décor items, projects for children, and craft 
objects. The stitch creations in this series were simplistic in the 
stitch components (usually a single pattern) but the results were 
often dramatic!

These stitch exercises were created for Models 530 and 730 
(the original) that were purely mechanical machines. Remember, 
this was before the days of computers and automatic anything. 
There were no computerized functions to aid in the creation of 
these wonderful stitch motifs. The only tools available were the 
BERNINA® accessories, i.e. presser feet (introduced with the 
530) and the FHS, Free Hand System (fi rst engineered for Model 
730). The rest of the creating process remained with the stitcher 
and his or her imagination.

The good news about these unique embellishments is that they 
can be recreated on just about any BERNINA® model since the 
530. And, the even better news is that the computer functions 
and advanced features on today’s machines make it much sim-
pler to execute them. So, take a look and see how these “time-
less” stitch decorations can be sewn to adorn your next project.

BY JILL DANKLEFSEN

Note: The stitch numbers listed are for artista models. If using 
BERNINA® models other than artista, look for similar stitches. 
For a Stitch Conversion Chart covering current BERNINA® 
models, go to www.berninausa.com > Sewing Studio >Basic 
Training > Stitch Conversion Chart

Satin Patches
Create an interesting “patch” 
using one decorative stitch 
and then scatter it across the 
fabric using a contrasting color 
of thread, making an all-over 
pattern.

Stitch: artista #407
Feature and Functions: Combi Mode/Memory, Single 
Pattern, Securing function
Fabric Preparation: Back fabric with OESD Tear-Away 
stabilizer; using chalk, draw a vertical line to mark the 
center of the design. Note: After each line of patterns is 
stitched, draw a line marking the position of the next line 
and use as a guideline when stitching.

8

Recreating Timeless 
Stitch Embellishments

        Sewing machines have been around for over 
      150 years and before the age of computers 
    remained relatively unchanged. They sewed straight 
stitches and then later, zigzag and pattern stitches were 
added. By today’s standards, they were comparatively 
simple and uncomplicated to use. But, just because 
they had fewer features doesn’t mean that the stitcher 
was limited in creative possibilities.



STEPS:
1.  Create a simple memory combina-

tion of 3 patterns of #407 separated 
by one repeat of straight stitching 
(change the stitch length to 1.0mm)

2.  Attach Open Embroidery Foot 
#20/20C

3.  Sew the combination down the 
marked center vertical line; close 
Combi Mode/Memory. 

4.  Select stitch #407 and Single Pat-
tern; if available, engage Securing 
function.

5.  Sew one #407 to the right and one to 
the left of the vertical row of stitching, 
turning the fabric as needed. Begin 
sewing from the center of the middle 
motif, stitching perpendicular to the 
vertical line of stitching.

6.  Sew single pattern repeats, stitch-
ing in the direction of the arrows and 
rotating the fabric as needed.

7.  Add the single pattern repeats to 
complete the patch, stitching in the 
direction of the arrows and rotating 
the fabric as needed.

8.  Remove stabilizer and position fabric 
as desired to sew additional patches.

A Study in 
  Contrasts 
This striking yet simple tech-
nique combines two hues of 
fabric and thread for a colorful 
coordinated look.

Stitch: artista #406
Feature and Functions: Half Speed, Pattern Begin, Mirror 
Image Right-Left
Fabric Preparation: Back fabric with OESD Tear-Away sta-
bilizer; using chalk, draw a horizontal line at the 
beginning point.

STEPS:
1.  Seam three fabric strips 

in alternating colors (color 
1, color 2, color 1), leav-
ing wide enough seam 
allowances to support 
the stitches; press seam 
allowances open.

2.  Attach Open Embroidery 
Foot #20/20C.

3.  Select stitch #406; use 
the widest stitch width 

     unless working with a 9mm machine – then adjust stitch width 
to 6mm.

4.  Adjust motor speed to ½ speed – you need to be able to 
control the stitching of the second pass to match the stitches. 
Setting the motor at half speed and sewing with the foot con-
trol completely depressed results in even, consistent stitching.

5.  Add two layers of OESD Medium-weight Tear-Away stabilizer 
under the seam allowances, as this is a heavy satin stitch.

6.  Align the inner left toe of the foot with the seamline as shown, 
positioning the starting point on the horizontal chalk line.

7.  Sew a line of triangles in a contrasting color along the seam-
line.

8.  Change the thread color and position the fabric at the begin-
ning horizontal chalk line; touch Mirror Image Right-Left, if 
available or simply rotate the fabric and the Pattern Begin 
button.

9.  Sew the second row of triangles, aligning the stitch patterns; 
remove stabilizer and press. 

Pintuck Texture
Alternating groups of double 
needle pintucks with a decora-
tive stitch adds texture and 
depth to an otherwise plain 
fabric. Use this simple embel-
lishment alone or stitch several 
of them side-by-side to create 
all-over texture.

Stitch: artista #425
Feature and Functions: Double Needle Limitation, 
if available
Fabric Preparation: Using chalk, draw a vertical line to 
mark the position of the left pintuck.

STEPS:
1. Attach Pintuck Foot #31 (5-groove).
2. Insert a 2.5 double needle into the machine.
3.  Optional: For raised pintucks, thread heavy cord such as 

gimp or perle cotton up through the hole in front of the 
needle opening on the stitch plate. For more information, 
see Feet-ures, Vol. 1.

4.  Starting at the chalk line, stitch 4 rows of pintucks, leaving 
a space between the 2nd and 3rd pintucks to add a 
decorative stitch.

5. Remove the double needle; leave the pintuck foot on.
6.  Insert a standard Universal needle and change thread color 

if desired.
  7. Select Stitch #425. 
  8.  Add tear-away stabi-

lizer behind the fabric
  9.  Using the Pintuck foot, 

straddle the pintucks 
and sew the decorative 
stitch between 
the rows.

10.  Remove the stabilizer 
and press from the 
wrong side.

9



GETTING STARTED

• Click on the New icon or select File>New.
• Select the Picture View; click Load Picture.
•  From the Artwork Folder (C:\My Designs\

Artwork), click on the Files of Type drop 
down menu, select All Picture Files, then 
select the A_East_008b.jpg 

• Select the Design View; select Show All.

USING THE OPEN OBJECT TOOL

•  Select the Open Object tool. From the 
Stitch and Color bar, select Outline > 
Stemstitch and Color > C19 (Khaki).

•  Set the boundary points (red circles) to 
create the “spokes” of the fan: Left click 
once at one end of the spoke, left click at 
the opposing end of the spoke; press Enter.

• Select Object Properties
 -  From the Outline Stitch tab, select 

Pattern Run from the Stitch Type drop 
down.

 -  Click Select. From the Pattern drop 
down, select Embellishment.

 - Select 601, OK and OK
•  Beginning on the left side of the fan, set 

boundary points across the top. Press 
Enter to complete the object.

•  Select the line, from the Color Palette, 
select C19; touch the Esc key on your 
keyboard to turn the tool off .

NOTE: When digitizing for Advanced 
Appliqué, the key is to keep the cover stitch

sewing order in mind. Open Objects need to be 
digitized fi rst for the Closed Object stitches to 
cover the ends of the Open Objects. To illustrate 
this point, go to the Applique folder (C\:My 
Designs\Tutorials\Applique) and select Appliqué 
Finish. Hide the fabric and select Slow Redraw. 
Remember the order of stitching is dependant on 
the order in which the objects are digitized.

USING THE CLOSED OBJECT TOOL

•  Select the Closed Object tool. From the 
Stitch and Color bar, select Outline-Single 
and C12 (Brown).

•  Set boundary points around the perimeter 
of the fan. When fi nished, press Esc. 

•  Select the Picture View. Select the graphic 
and Delete.

• Return to the Design View.

Note: Let the software close the object; the last 
point should follow the last directional change 
before the fi rst point. Th e software will create 
a smoother edge than trying to join the points 
manually. Don’t be concerned about perfection, 
points may be edited when object is complete.

DIGITIZING REVIEW
Right click to set curves, left click to set corners, backspace to erase 
the last point. It takes three points to change direction, add one 
more point before deciding to backspace. Keep the number of 

points to a minimum for the smoothest shapes.
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Th e exclusive Advanced Applique function found in 
V5 of the BERNINA® DesignerPlus Embroidery 
Software takes creativity to a new level. Combine 
stitch types and colors with embroidered details from 
the Creative Genes Design Collection to add texture 
and dimension to any appliqué project.



RESHAPING THE SPOKES

•  Zoom in on the top of the fan. Each of the 
spokes should slightly overlap the outline. 

• Reshape if needed. 
 - Select the spoke; select Reshape.
 -  Click and drag the node just past the 

boundary of the outline. Press Enter.
 -  Click on the next spoke that needs 

reshaping.
 -  Continue until all spokes have been 

reshaped.
• Select the fan outline. 
•  From the Outline Stitch menu select 

Satin; touch Esc.

GENERATING THE APPLIQUÉ

• Select Show All; select Edit > Select All
• Select Advanced Appliqué.
 -  Th e fan should be fi lled with white 

hash marks to indicate it is an appliqué 
area.

 -  Under Fabric Patches section, select 
Place color and Fabric in Patches.

 -  Select Benartex 2006 > Giverny >
1004-11.

 -  Click on the applique design to set the 
fabric in place.

 - Click Back and Close.

Notes: All areas to be appliquéd should be 
fi lled with white hash marks. If an area that 
is part of the appliqué is uncovered, close the 
dialog box, select the uncovered area and 
reshape the outline to extend into its 
adjoining boundary line.

To recolor an area, select another fabric and 
click on the area that is to be re-colored.

INSERTING DESIGNS 

AND CLONING

• Select File > Insert Design.
•  From the Ornaments folder 

(C:\MyDesigns\Ornaments), 
select Peppermint Swirls 1; 
Open.

•  Click on the design to view the 
open Rotation handles. Rotate 
the design, drag into place at 
the bottom of the fan.

•  File>Insert Designs. From the 
Creative Genes Design collec-
tion, select Design #39.

•  Rotate and position on the left 
side of the bow.

•  Right click and drag the fl oral spray to the 
right to generate a Clone; Mirror Horizon-
tal. Position on the right side of the bow.

•  Insert Design #35 from the Creative 
Genes collection.

•  Left click on the Scale by 20% Down / Up 
to reduce the size of the fl ower by 20%.

•  Right click and drag to generate a Clone. 
Scatter Clones on the fan; rotating, scaling 
and positioning in a pleasing arrangement.

•  Select the last color chip on the Color Film 
(the small fl owers).

•  From the Color Palette, select C9 (Dark 
Red)

USING PATTERN STAMPS

• Select Arrange > Pattern Stamp.
•  From the Symbol Set drop down, select 

Candlewicking; Knot 3mm; OK
•  Click to anchor the stamp, position the 

motif in the desired justifi cation; click to 
complete the stamp. 

•  Add Candlewicking pattern stamps in a 
pleasing arrangement.

• Touch Esc to deactivate.

ADDING THE FINISHING TOUCHES

To combine like colors and reduce thread 
changes: Arrange > Stitch Sequence. Answer 
yes to the Stitch Sequence question.

Note: Stitch Sequence optimizes the stitch-
ing sequence of the design by eliminating the 
number of hoopings, color changes and trims. 
Grouped objects are color sequenced. Mono-
grams and Advanced Appliqué objects will not 
be included in the re-sequencing unless they 
have been Broken Apart. 

OUTPUTTING THE FINISHED 

DESIGN

• Save the completed design fi le.
•  To write the design to a BERNINA® USB 

stick for use in upgraded artista 200 and 
and the 730, select File > Save As. 

•  Select the appropriate drive in the Save 
In fi eld.

•  Click on the arrow beside Save as Type. 
Select V4.0 Bernina A730/200 machines.

• Click Save.

Note: Design fi les saved in the V5.0 format 
may be sent directly to the machine via the 
ADX dialog box or File > Card Machine 
Write as both of these options automatically 
translate the design fi le into language the 
machines understand. When using the 
Save as function for the artista 200/730, 
remember to select the appropriate fi le type 
(V4 Bernina a730/200 machines). Doing 
so translates the embroidery information 
appropriately for the machine fi rmware. 

Th e following tools from the 
BERNINA® Embroidery Soft-
ware V5 are used in creating 
the Fan Dance design.

 New

 Load Picture

 Show All

 Open Object

 Object Properties

 Closed Object

 Zoom

 Reshape Object

 Advanced Applique

 Color Film
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CUTTING MOM’S SLIPPERS
Refer to cutting diagrams on page 15.  

Transfer all sewing construction markings.  

Note9  Mom’s Slippers have left- and right-

facing pieces.

� From the fusible knit interfacing, cut 2 

pieces 14" x 18".  Fuse to the back of 

Lavender and Heliotrope silk. 

� Layer the Lavender and Heliotrope silk.  

Using Pattern C, cut 2 left and 2 right.  Using 

Pattern B, lightly trace 1 left and 1 right. Set 

aside traced piece.

� Cut a 12¼" square of interfacing and fuse 

it to the back of the Vintage Taupe silk; cut 

out the fused silk square. This piece will be 

quilted for the inner sole.

� Using Pattern A: cut 1 left and 1 right from 

the Shaggy Suede, and the Fusible Fleece.  

Cut the Fusible Fleece 3⁄8" smaller than the 

pattern.

� Using Pattern B: Cut 1 left and 1 right from 

the Wool Batting ½" larger than the pattern.  

Also cut one 12¼" square of wool batting.

CUTTING DAUGHTER’S SLIPPERS
From cutting diagrams, transfer sewing con-

struction markings.  Note9  Daughter’s Slippers 

do not have left- and right-facing pieces.

� From the fusible knit interfacing, cut 2 

pieces 14" x 18".  Fuse to the back of Lilac 

Mist and Off White silk.  

� From Lilac Mist: Using Pattern F,  cut 2 (fl ip 

pattern to cut full size or cut on folded 

piece). Using Pattern E, trace 2 lightly and 

set aside. 

� From Off White silk, using Pattern D, cut 2.  

Also cut 2 from Pattern F.  Using Pattern E, 

lightly trace 2 and set aside.   

� Using Pattern D, cut 2 from the Shaggy 

Suede, and the Fusible Fleece.  Cut the Fus-

ible Fleece 3⁄8" smaller than the pattern.

� Cut 2 pieces from the wool batting ½" 

larger than Pattern E.  Also cut one 11" 

square.

QUILTING THE INNER SOLES
Layer wool batting square between muslin 

and traced inner sole, right sides of fabric fac-

   ozy, charming, elegant . . . what could be more fun than these 

delightful mother and daughter silk slippers? Designed for you and 

your little one by noted silk artist Mary Jo Hiney.  Wear them for 

breakfast on Mother’s Day.  Your special day will be that much sweeter!

S U P P L I E S
Mom’s Slippers, all sizes:
�  Silk Adaptation Individual Silk Pieces —

each piece is 14" x 18". Our slippers used:
 Lavender— (top, side-back)

Heliotrop— (lining top, side-back)
Vintage Taupe— (inner sole) – 

Brown Shaggy Suede: 6" x 26"  for outer sole 
Muslin: 12½" square for quilted inner sole backing
Fusi-Knit fusible interfacing: 20" x 1 1⁄8 yard
Hobbs Tuscany wool batting: 1⁄3 yard
Fusible Fleece: 5½" x 24"
Elastic: 1 yard of ¼"-wide
Isacord Embroidery Thread:

Bark—#1055 and Wild Iris—#1830
Bead Gravy: Amber Chasseur

Daughter’s Slippers, all sizes:
� Silk Adaptation Individual Silk Pieces —

each piece is 14" x 18". Our slippers used: 
 Lilac Mist: top, side-back 
 Off White: lining top, side-back, inner sole 

Tan Shaggy Suede: 5" x 20"  for outer sole
Muslin: 11" square for quilted inner sole backing
Fusi-Knit fusible interfacing: 20" x 7⁄8  yard
Hobbs Tuscany wool batting: 1⁄3 yard
Fusible Fleece: 4¼" x 19" piece
Elastic: ¾ of a yard of ¼"-wide
Isacord Embroidery Thread: Isacord Wild Iris—#1830
Bead Gravy: Sparkling Cranberry

For Mom’s or Daughter’s slippers:
OESD PolyMesh Stabilizer
Reverse Pattern Foot 1/1C
HRFive temporary spray adhesive
Size 90/14 Universal and Embroidery needles
Beading or milliner's hand-sewing needle
Ballpoint bodkin

Silk 
Mother & Daughter

C
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Note: Silk Adaptations and Bead 
Gravy available at your local 
BERNINA® store.



BY MARY JO HINEY

k Slippers
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ing out.  With Wild Iris Isacord, machine 

quilt the layered piece in a random fashion 

using decorative stitches.  For Mom’s use 

artista stitch #820.  Quilt the Daughter’s 

using artista stitch #730.  Note: If using 

BERNINA® models other than artista, look 

for similar stitches.  For a Stitch Conversion 

Chart covering current BERNINA® models, go 

to www.berninausa.com > Sewing Studio > 

Training > Stitch Conversion Chart

Once quilted, trace 2 inner soles (pattern A or 

D) onto the quilted piece.  Machine stitch a 

scant 1⁄8" inward from traced line.  Cut inner 

soles from the quilted piece on traced lines.  

Fuse the soles cut from the fl eece to the 

muslin side of the inner soles.

EMBELLISHING THE TOPS 
Back the traced pieces for top (pattern B or 

E) with PolyMesh Tear-Away stabilizer.  

Moms’ Slippers: Using Isacord Bark and 

artista stitches #718, 820, 824, and 826, 

embellish the tops by stitching in a random 

fashion.  The purpose is to have the com-

bined designs appear as one.  Practice the 

designs on scrap fabric fi rst to get a feel for 

placement.

Daughter’s Slippers: Using Isacord Wild Iris, 

embellish tops with artista script lettering.  

Embroider “Sweet Dreams” centered on one 

top and “Rise n Shine” cen-

tered on the other 

top.  Practice on 

scrap fabric to 

get a feel for 

placement.  Note: If using a machine not 

equipped with lettering, select your favorite 

decorative stitches and create an all-over 

pattern.  

Tear away stabilizer.  Press tops.

SEWING THE TOP
When sewing, remember that you are making 

two slippers—one for the left foot and one 

for the right.

For Mom’s Slippers: place embellished top 

with lining top.  Retrace with top pattern, as 

the stitching may have shrunk the fabric a bit.  

Cut out tops from both layers.  This step does 

not apply for Daughter’s Slippers.

Pin the top and the top lining pieces together 

with right sides facing while layering the 

wool batting underneath the wrong side of 

the lining.  

Sew the “ruffl e” edge.  Trim batting from the 

seam allowance as close to the seam line as 

possible.  Edge press and turn right side out.  

Press from lining side.  Pin and baste-stitch 

layers together along outer edges.  Trim away 

excess batting.

Working from top right side, sew casing space 

as indicated on the pattern.

Use the bodkin to slip elastic through cas-

ing.  Pin elastic at outer edges of casing and 

then machine sew ends in place.  See Fig. 1.  

Use the following measurements for elastic, 

adjusting as necessary to suit personal taste:

 Mom’s Slippers Daughter’s Slippers

 Small: 4½" Small: 3½"

 Medium: 5"  Medium: 4"

 Large: 5½"  Large: 4½"

Beautiful Quiltagami: 
New Ideas for Fabric Folding

by Mary Jo Hiney

Quiltagami 
combines the 
traditions and 
techniques of 
quilting and 
origami to 
enable you to 
create visually 
striking, and 
invitingly 
tactile, to add 
dimension to this wonderful collection of 
fashion accessories and home dec projects. 
Follow Mary Jo’s instructions for fabric fold-
ing and soon you will have butterfl ies, roses, 
penquins and—yes, it’s true, elephants!—
adding life to  your next sewing endeavor.

The Portable Crafter Series
Quilting

by Mary Jo Hiney

Just because 
you’re away 
from home 
doesn’t mean 
that you can’t 
quilt some-
thing special 
for yourself 
or someone 
you love! This 
sweet little 
book has so many beautiful projects—
pillows, wall hangings, handbags, little totes. 
And all with that Mary Jo Hiney touch—
simple design with elegant undertones. 

Look for more silk projects from Mary Jo 
in her upcoming book, Simply Silk, 
published by Krause Books, available in 
December 2007.



SEWING THE SIDE-BACK
For Moms’ Slippers, sew side-backs together along 

back seam line.  Press seam allowance open.  

This step does not apply for Daughter’s Slippers.   

Pin side-back and side-back lining pieces 

together with right sides facing.  Sew the “cas-

ing” edge.  Edge press and turn right side out.  

Press fl at from lining side.

Sew casing space by stitching 3⁄8" inside fi n-

ished edge.  Stay-stitch the remaining edges 

together.  

For Daughter’s Slippers: sew ¼" from fi nished 

edge, then sew again 3⁄8" from fi rst row of 

stitching.  This creates the ruffl e along top 

edge of side-back.

Slip a length of elastic through casing, pin-

ning elastic at the outer edges and sewing 

ends in place.  See Fig. 1. Use the following 

measurements for elastic, adjusting as neces-

sary to suit personal taste:

Mom’s Slippers Daughter’s Slippers

 Small: 10–11" Small: 7-8"

 Medium: 11-12" Medium: 8-9"

 Large: 12-13" Large: 9-10"

SEWING THE TOP, SIDE-BACK TO INNER SOLE
Stay stitch the lower edge of the side-back 

except along the gather space.  Pin side-back 

to inner sole, lining sides together.  Align 

side-back ends to stars shown on pattern.  

Clip side-backs to stay stitching as needed.  

Where side-back will be sewn to heel, hand 

gather along space indicated on pattern.  

Pull gathering thread as tightly as necessary 

for side-back to fi t heel area on inner sole.  

Secure thread and pin gathers in place.

Pin top to inner sole, lining sides together, 

aligning ruffl e ends to side dots on soles 

shown on pattern—top is overlapped onto 

side-back.  Sew top and side-back to inner 

sole.  See Fig. 2. 

SEWING THE SOLE
Pin top and side-back so they are fl at against 

the inner sole in order to keep those parts 

away from the sole seam line.

Pin and sew right side of outer sole to right 

side of the inner sole/top/side-back, break-

ing stitches to leave opening indicated by 

squares on sole pattern.  See Fig. 3. 

Trim inner sole seam allowance to a scant 
1⁄8".  Trim outer sole seam allowance to a gen-

erous 1⁄8".  Turn slipper right side out through 

opening.  Push out seam lines.  Hand-sew 

opening closed.  

FINISHING TOUCHES
Hand-sew Bead Gravy beads individually to 

top ruffl e edge, spacing beads about 1⁄8" apart.  

Use the shades of beads in a random fashion.  

Hand bead the tops as desired.

Sweet Dreams!
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Cutting Diagram - Mom’s Slippers
      as shown for size Large

Cutting Diagram - Daughter’s Slippers
      As shown for size Large
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Figure 1

Figure 3

Figure 2
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Mother/Daughter Silk Slippers
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Enlarge patterns @ 200%
Use a 3⁄8" seam allowance unless otherwise noted.



GATHERING THE STRIP
Using a 4-thread balanced stitch, join all 
strips right sides together, to form one 
long strip. 

Set serger for a 3-thread rolled hem with 
decorative thread in the upper looper. 
Begin roll hemming at the top left corner 
of the spiral strip, gently curving towards 
the right edge; hem the entire length of 
the spiral strip.

Set the serger to a 4-thread balanced 
stitch and attach the BERNINA® Serger 
Gathering foot or Gathering attachment. Set the differential 
feed to 2.0 and the stitch length to 4. Gather the entire length 
of the spiral strip’s raw edge.

This rich-looking, luxurious pillow 
starts with a ruffl e easily gathered using 
a serger, then stitched in a spiral with 
a sewing machine. A great project that 
looks more complicated than it is!

Supplies
• 5/8 yard for pillow base and back – 100% cotton
•  3/4 yard for ruffl ed spiral - fabric shown is an 

Ombre Crushed Taffeta that comes pre-crinkled
• 5/8 yard fusible batting
• BERNINA® serger
• BERNINA® serger gathering attachment or foot
• Reverse Pattern Foot #1/1C & quilting/seam guide
• Edgestitch Foot #10/10C
• 4 spools of serger thread
• 3 spools of coordinating or contrasting 
   Isacord thread for rolled hem
• 18” Round pillow form
•  Cut A Round Ruler (Size 6”-19”) by Cheryl Phillips
• 15/8” Button to cover

Cutting 
Back  Two - 11½” x 19” rectangles
Front One - 20” x 20” square
Fusible Batting One - 20” x 20” square
Ruffl e  Eight 3” strips across the fabric 

width (includes extra length to 
accommodate different gathering 
ratios of different fabrics and 
serger settings)  
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By Sara Snuggerud



ATTACHING THE RUFFLE
Fuse the 20” batting square to the wrong side of the pillow 
front. Using the Cut A Round ruler and a rotary cutter, cut a 
19” circle for the pillow front.

Attach 
Reverse 
Pattern Foot 
#1/1C to 
the sewing 
machine 
and insert 
the seam 
guide to 
the back, 
setting it 1” 
to the right 
of the foot. 

The spiral ruffl e starts from the outer edge and is sewn 
toward the center. Measure in 2” from the edge of the fused 
pillow front. Position the curved rolled hem on the pillow front 
and begin sewing around the perimeter of the pillow. Stitch 
with a straight stitch placed within the 4-thread stitch of the 
serged ruffl e. After completing one round, gently curve the 
ruffl e to begin stitching a spiral 1” away from the previous 
ruffl e (seam guide should follow the previously stitched edge).

As the spiral tightens near the center, extra ruffl e will need to 
be hand-placed before stitching to help the ruffl e lay fl at. If 
needed, remove the pillow from the machine and pin extra 
fabric in place before stitching. Once enough fabric has been 
stitched, trim the excess ruffl e, leaving 2” extra. Fold under 
this extra fabric to hide the ruffl e’s raw end. 

PILLOW ASSEMBLY
Pillow back: Serge one 19” edge on each rectangle with a 
3-thread balanced overlock stitch. Fold the serged edge to 
the wrong side and edgestitch in place using Edgestitch Foot 
#10/10C. Overlap the pillow back rectangles about 5”; pin.  

Pin the spiral ruffl e’s outer edge toward the center to avoid 
stitching it into the pillow edge.

Center the pillow front circle on the pillow back rectangles, 
right sides together.

Using a 1/2” seam allowance, sew around the pillow with 
the front circle on top. Trim excess pillow back fabric even 
with the pillow front. Using a 4-thread balanced stitch, serge 
around the pillow edge. Turn pillow right side out and insert 
pillow form. 

Following package directions, cover a button with ruffl e 
fabric. Hand-stitch in place in the center of the pillow front.
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BY DEBBI LASHBROOK

Supplies
•  Purchased rectangular 

shawl with fringe on 
each end

• Rotary cutter, mat

•  Studio BERNINA® Exclusive 
Linen Closet Design Collection 
(optional)

•  HRFive Temporary Spray 
Adhesive

For elastic-banded 
skirt:

• 1” wide elastic to fi t waist

• Reverse Pattern Foot #1/1C

For fi tted skirt:

• 9” Invisible zipper

• Waistband interfacing

• Trouser hook & eye 

•  Straight skirt pattern of choice

• Presser Feet: 
      - Invisible Zipper Foot #35

- Edgestitch Foot #10/10C
- Reverse Pattern Foot #1/1C
-  Bulky Overlock Foot #12/12C

     - Zipper Foot # 4
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Want a quick project 
to add pizzazz to your 
wardrobe? Make a quick 
& easy skirt from a pur-
chased fringed shawl! 
The fringe becomes the 
“hem” of the skirt and 
you can make an elastic-
banded, serged skirt for 
the fastest, easiest way 
or you may decide on a 
more tailored, darted skirt. 
Embroider a plain shawl 
or start with a decorated 
one for a unique addition 
to your wardrobe. You are 
the designer!



Measuring and Cutting
Begin your project by taking a few measurements and by deciding what type of fi t you want in your skirt: easy-fi t with an elastic waist or a 
more tailored fi t with waistline darts. The Measurement Chart below will help you determine the cutting dimensions of the skirt.

Next, measure your waist, hip, and the desired fi nished length of your skirt; add these to the chart. 

After deciding on the fi nished length of the skirt, add 5/8” to this measurement for the seam allowance at the top of the skirt. Finally, add your 
hip measurement + ease + seam allowance and place the total in the appropriate column for the hip. This completes the chart. Note: If your 

abdomen measures larger than your hip, use this measurement for your hip.

To determine the available length of the skirt pieces, you need to allow for a 3” strip that forms the waist-
band of the skirt (about 1” fi nished). A 3” piece will be cut for each skirt length. These pieces are used 
for either the elastic banded skirt or the tailored skirt (see cutting diagram). Depending on the desired 
fi nished length of the skirt, you may have a leftover piece.

For the elastic banded skirt: 
You can add the minimum ease or you can use the full width of the shawl. For a more fi tted, elastic 
banded skirt, you will cut off any extra width beyond the total needed for fi t. For example, if the shawl 
measures 54” across and your hip body measurement + 3” of ease + four seam allowances (5/8” each) 
is 42”, you will cut 12” off the width of the shawl. The waistband of the skirt will be 3” wide (about 1” 
fi nished) and the length of the waistband will be an amount equal to the top of the skirt. For a looser-
fi tting skirt, use the full width of the shawl without cutting any away.

For the darted, fi tted skirt:
Use your favorite fi tted skirt pattern to serve 
as a cutting guide to shape the skirt waist 
area. Fold the shawl down the lengthwise 
center and align the fold line of the pattern 
with the fold of the skirt. If your skirt back 
pattern has a center back seam, align the 
cutting line of the pattern with the fold line of 
the skirt, thus eliminating the seam allowanc-
es at the center back. Mark the darts using 
your preferred method of marking. 

The waistband for the fi tted skirt is seamed 
at one side. The band is 3” wide (about 1” 
fi nished) and the length is your waist measurement 
+ 1” ease + 1” overlap + 1¼” for seam allowances. 

 Using a rotary cutter, mat, and ruler, cut the skirt pieces 
into the size of rectangles needed.

Constructing the Elastic Banded Skirt
If using the entire width of the shawl, there is no need to fi nish the edges, but if you have 
removed width, fi nish the seam allowances of the skirt pieces. A three-thread or four-thread 
serged seam fi nish will neaten the edges nicely. 

Carefully align the embroidered design at the side seam of the skirt and stitch from the bottom 
of the skirt to the top of the skirt. Then, seam the two waistband pieces together along one 
short end. Press the side seam of the skirt and the side seam of the band open. Next, press 
the waistband piece in half lengthwise, wrong sides together.
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Optional Embroidery Accent
Add a subtle touch of embroidery using a BERNINA® exclusive design from The Linen Closet design collection. Note: Add this 
embellishment after cutting the skirt pieces but before beginning construction.

Software Preparation:
Open the BERNINA® Embroidery Software program and open the fi le, BE10233, from the Linen Collection. Zoom in 
at the top of the design by selecting the Zoom tool and left click on the design (V5) or click and drag a box around 
the top of the design (V4). You can easily change the location of the fi rst stitch of the design by selecting Arrange > 
Start and End. Select the option “Digitize Start Needle Position” in the dialog box; then select OK. Left click on the 
top end of the design as shown in the illustration. This places the starting point of the needle at a place to easily 
align the repeated design across the bottom of the shawl. This design will be stitched twice in the Mega Hoop on 
both the front and back of the skirt.  

Stitching the design in the Mega Hoop:
Mark a placement line the desired distance from the hemline on the front and the back of the cut skirt pieces with your favorite 
marker. Mark the center of the skirt with a short line perpendicular to the fi rst mark on both skirt pieces. 

Use HRFive Temporary Adhesive Spray to adhere two layers of Aqua Mesh stabilizer 
together. Spray the top stabilizer surface with HRFive and place the skirt on the stabilizer, 
positioning the marked skirt in the center of the stabilizer with the skirt center toward the 
top of the stabilizer. Use the hoop template and place the shawl and stabilizer in the hoop 
so that the marking is aligned with the centerline of the template and the center of the skirt 
is at the top of the hoop.

Aligning the start point with the marked line:
When the design is selected in the machine, the needle will travel to the fi rst needle position. If necessary, adjust the position of the 
needle by moving the hoop right or left and up or down to align with the marked line of the skirt. Embroider the design.  

Hoop the other side of the skirt piece using the same method to align the placement lines of the skirt with the center of the 
stabilizer, but placing the center of the skirt toward the bottom of the hoop. Select vertical mirror image in the machine to reverse 
the start point of the design. Note: You may also use the software to change the start point to the bottom of the design. Align the 
design start point with the end of the fi rst embroidered design. Embroider the design from center out toward the side. Repeat this 
process for the other shawl piece.

Align the cut edges of the band to the cut edges of the skirt and serge together. Press the serged seam toward the skirt.
Cut a piece of elastic a comfortable waist measurement plus 1”. Use a bodkin to insert the elastic through the casing. 

Pin the remaining side seam of the skirt, matching the casing edges and the optional embroidered strip edges (see below). Serge the seam, 
press, and you are done! 

Constructing the Darted Skirt
Stitch the darts, then press the darts toward the center front and the center back. Finish the side seam edges with a three or four-thread 
overlock stitch.

Press the 5/8” seam allowance toward the wrong side of the skirt where the zipper will be inserted. This press line will serve as a guide for 
inserting the invisible zipper. Pin the right side of the fully opened zipper to the right side of the skirt, aligning the coils of the zipper with the 
pressed line. Guide the zipper coil into the groove of the Invisible Zipper Foot #35 as you lower the presser foot. Stitch from top to bottom. 
Repeat for the other side of the zipper tape, guiding the coils through the other groove of the foot.
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Studying BERNINA® sewing magazines 
in the 1960’s

Attach Bulky Overlock Foot #12/12C to the machine. Stitch the seam from the bottom of the skirt to the top, stitching as close as possible 
to the zipper. If a small opening occurs, use Zipper Foot #4 to close it. 

Stitch the remaining side seam of the skirt from bottom to top using Reverse Pattern Foot #1/1C. Stitch the waistband pieces together. 
Press the skirt side seams and the waistband seam open.

Waistband: Press your favorite waistband interfacing on the wrong side of the skirt waistband. Fold the waist-
band in half lengthwise and press. Pin the waist-
band to the skirt, right sides together, extending 
the underlap side of the waistband 15/8” and the 
overlap side 5/8” beyond the skirt edge. Stitch the 
seam using Reverse Pattern Foot # 1/1C.  

Fold the waistband right sides together and stitch the overlap side of the 
band even with the zipper in the skirt. Stitch the underlap side along the 5/8” 
seam allowance, pivot at the corner, and stitch the underlap extension to the 
zipper edge.  

Grade the seam allowances along these edges, leaving the seam allowance 
that is closest to the outside of the band the longest. Turn the waistband 
right side out and press.

Use Edgestitch Foot #10/10C to “stitch in the ditch” in the well of the seam 
that attaches the band to the skirt.

Sew a skirt hook & eye to complete the waistband and be prepared to 
answer the question, “where did you fi nd that skirt?”
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Create this lovely bordered 
tablecloth using the Border 

Calculator Software and 
directions from 

www.berninausa.com. 
Log on and go to 

Sewing Studio > Free Projects.



Lately, I’ve found myself 

stymied. I do the same-

old, same-old things 

with my quilts and it’s 

really frustrating! I want 

to break out and do the 

innovative and artistic 

quilts I envision in my 

head—but somehow 

life, my lack of space 

and okay, yes, my self-

doubts, get in the way. 

I fi nd myself not starting 

projects, even though I’ve 

bought the fabric, pattern and 

notions. I fi nd myself dreading the 

quilting, afraid I’ll screw up a quilt 

I’ve come to love during cutting and 

piecing. I fi nd myself making false 

starts with projects, yet never actually 

sewing a stitch. Who knew creativity 

came with such a price?

I asked therapist Charlotte Kasl, PhD, author of 
If the Buddha Got Stuck: A Handbook for 

Change on a Spiritual Path, about why people 
get stuck and she told me it’s often because 
they can’t handle the anxiety that comes with 
trying something new—and not being perfect 
right off the bat. But these are just negative 
thinking patterns we’ve learned, she says. We’ve 
got to fi ght these thoughts by replacing them 
with empowering statements, saying, “I can do 
it” instead of “I’ll just screw it up.” Because as 
the old saying goes, where there is a will, there 
is a way. 

Boosting Your Sewing Power
Creativity isn’t for sissies. You’ve got to put in the effort--even pros 
have practiced their craft for years and learned to keep going in the 
face of challenges. For starters, try some of the following strategies 
for pulling yourself out of a creative rut.

•  Approach a project from a new angle.  Start in a different way 
than you usually do—at the side of a quilt rather than the middle, 
for instance. Or buy embellishments for a garment fi rst, matching 
fabrics second. “Start the process differently and you’ll create a 
bigger space for yourself to work in,” says Diane Ericson, a 
California fabric artist and creativity coach.  

 
•  Go back to the beginning. Try some basic quilting and sewing 

techniques—sewing straight ¼” seams and practicing your points 
can be therapeutic (and makes perfect, too). 

•  Start each sewing session with a practice piece. This 
might be a small postcard, a sampler, or simply a test scrap of 
material that you practice sewing your name on. But play for a 
few minutes to switch out of your role in daily life and into your 
role as a creative sewer.  

•  Organize your space and supplies. We know cleaning is far 
from tops on your list of things to do, but tidying your workspace 
and moving stuff around may help you to see projects differently. 
Decluttering can wipe out the cobwebs in both your craft space 
and your head. 

•  Make an excitement list. What attracts and fascinates you? 
What colors, what techniques, what styles? Excitement and 
passion are where creativity begins, says Gail McMeekin, MSW, a 
Massachusetts creativity coach and author of the inspiring book, 
The 12 Secrets of Highly Creative Women. 

•  Don’t judge. Allow yourself to be a beginner. “Judging your early 
artistic efforts is artist abuse,” says creativity guru Julia Cameron, 
author of The Artist’s Way. Instead, give yourself (and your quilts) 
permission to be imperfect. “If you have to make a project just 
right, you set yourself up with just one more chore to accomplish. 
You lose the joy,” notes Ericson. 

•  Meditate, take a walk, do some yoga, bake a cake—what-
ever relaxes you. Performing stress-reducing activities can help 
you fl ip the switch to a more creative state of mind and think 
through creative roadblocks. Even closing your eyes and 
breathing deeply for a few minutes can work wonders. 

•  Focus on the process as much as you do the 
fi nal product. Get lost in the joy of creating and 
experimenting instead of blindly forging ahead 
to fi nish. ‘Cause remember: Once you’ve 
made something, the experience is over.

24

Metro Collection by Benartex Fabrics

 BY NANCY MONSON



Spark Your Creativity
Sometimes we need a little help claiming the artist within, and these wonderful 
books can help: 

  The 12 Secrets of Highly Creative Women: A Portable Mentor by Gail McMeekin

This book by a creativity coach contains fabulous nuggets of advice and wisdom from women 
who have pursued creative paths in all walks of life, as well as exercises to help you awaken your own creativity.
 
  Art & Fear: Observations on the Perils (and Rewards) of Artmaking by David Bayles & Ted Orland 
An inspiring book about what making art is all about—the way it gets made, the fears that keep it from getting made, 
and some of our pervasive cultural assumptions about artists (like being born with talent is the only route to good art). 

  The Artist’s Way: A Spiritual Path to Higher Creativity by Julia Cameron

The bible on creativity by the guru of creativity. Julia Cameron’s fabulous book teaches you how to get past creative 
blockages (and she thinks we’re all blocked to one extent or another). The book contains a 12-week self-motivated program 
in discovering and recovering your creative self, as well as suggestions for starting an “Artist’s Way” group.
 
  Stretching Lessons: The Daring That Starts from Within by Sue Bender

A lovely little book about the author’s quest to grow her soul beyond her self-imposed limits…to stretch and become “bigger than.”  
 
  No More Secondhand Art: Awakening the Artist Within by Peter London

An interesting, somewhat academic, book on fi nding the originality and artist within yourself.
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    “How-To” BSR Videos
     Wondering what all the 

“BSR buzz” is about? Want 
to learn more about how to 
play with that new BSR 
feature on your machine? 
Check out the 15 video 
clips that cover BSR topics from basic informa-
tion to fun double needle play!

     Sewing Studio > BSR Showcase > 
The 1-2-3- of BSR

Quarterly Software Society – QSS 
Lesson 4 – Creating Monograms
Get more from your embroidery software with 
the new QSS software lesson on Creating 
Monograms! Explore several different ways to 
create monograms including the Monogramming 
feature of Version 5.
 Online Classes > Quarterly Software Society > 
QSS Lessons

  Studio BERNINA® Exclusive Designs Known for her beauti-
ful Baltimore Album quilts, Elly Sienkiewicz has translated those 
designs into an elegant collection of embroidery designs. Avail-
able exclusively from BERNINA®, many of these designs can also 
be stitched as appliqué designs.
 Products > Design Collections > Baltimore Elegance

340 Deco Embroidery Machine
The 340 Deco has everything you need to start creating 
with 100 carefully selected embroidery designs and the 
new USB port that lets you choose additional embroidery 
designs from the virtually unlimited range of compatible 
USB sticks; also reads embroidery cards.
What’s New > New Products > bernette 340 Deco

BERNINA® Border Embroidery Set
Create unique embroidered borders easily calculated to fi t 
your project. The new BERNINA® Border Embroidery Set 
enables you to select your design, input the measurements 
of your project, and then create a perfectly placed border 
design! No need to own other embroidery software to 
use this set and the Border set includes 30 beautiful Swiss 
designed motifs! 
What’s New > New Products > BERNINA Border 
Embroidery Set

 Log on and 
see what’s new at 

www.berninausa.com

Follow the paths 
below to see 

the latest on the 
BERNINA® USA 

website!



Add sensory details to fabric for baby with 
pintucks and decorative stitching. Baby Genius 
fabrics from Benartex are fun, colorful prints 
that are wonderful the way they are. But, you 
can make them even more fun and more 
interesting to Baby’s touch and sight by adding 
a few creative stitching techniques!
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See more 
Baby Genius Stitch 

Recipes at 
www.berninausa.com > 

Sewing Studio > 
Stitch Recipes > 

Whimsical Stitches 1
Sewing Circles

•  Attach Circular Embroidery Attachment #83 to the machine according to instructions included with it.•  Attach Clear Embroidery Foot #39 and insert an 80/12 needle.
•   Stabilize the fabric square with OESD Heavy Tear-Away.

•  Place the stabilized fabric square on the Circular Embroidery attachment as shown, positioning the center of the desired circle on the pin of the attachment; replace rubber guard on pin. Tip: If the Circular Embroidery Attachment is set at an “odd-numbered” notch (“0” is the center of the circle), your decorative stitches will match as you complete the circle!

• Sew a circle of decorative stitches.•  Adjust the attachment as desired and sew a second circle, changing thread color fi rst, if desired. When stitching 

is complete, remove the stabilizer and press.

PREPARATION TIPS

•  Prepare squares of fabric larger 
than the desired fi nished size 
as the stitching techniques may   
shrink the size of the fabric. When 
the techniques are complete, true 
the square and trim to the fi nal 
size. For these techniques, cut the 
squares 8” and trim to 6” 
after stitching.

•  Choose fun, bold 30 wt. thread 
colors. Mettler Cotton Embroidery 
thread (30/2) was used in the 
sample.

Raised Lines

•  Attach Pintuck Foot #31 (5-groove) and a 

2.5 double needle.

•  Engage Double Needle Limitation function or 

Security Program, if available.

• Select Straight Stitch.

•  Stitch along the vertical lines between the rows 

as shown; repeat the process, stitching along the   

horizontal lines next. 

Note: For more defi nition in the pintucks, cord them 

by feeding a narrow cord up through the hole in the 

stitch plate in front of the needle opening. Pull the 

cord out to the back (under the foot) and it will be 

incorporated into the tucks as they are stitched.

BY JILL DANKLEFSEN
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Freezer Paper Patterns

Make a pattern for the rug by cutting the following from freezer paper:
 • 12” circle 
 • 12½” circle
 • 2½” x 3” rectangle - round the corners on one short end of each for the tongues
 • 3” x 3¼” rectangle - round the corners on one short end of each for the tongues

Cutting Fabric Pieces

Press the freezer paper patterns to the wool: 
12” circle and smaller tongue to the black wool (1 circle and 12 tongues)
12½” circle and larger tongue to the contrast wool (1 circle and 12 tongues)  

Needle Punch Floral

Attach the Decorative Needle Punch Accessory Set to 
an applicable BERNINA® machine following the direc-
tions included with the set. Note: Viewing the included 

DVD is recommended before fi rst using the Needle 

Punch Accessory Set.

Using chalk, lightly draw vines and leaves in the center 
of the black circle, similar to the photo above. 

Punch green yarn or roving over the chalk lines and 
shapes. Position various colors of yarn or roving at the 
end of each vine, loosely shaping each one into a 

BY NINA MCVEIGH

Supplies

• ½ yd black felted wool

•  ½ yd contrast felted 
wool

•  Multi-colored wool 
roving or loosely woven 
yarn (should have green 
and fl oral colors)

•  HRFive Spray & Stick 
temporary spray 
adhesive

•  Mettler Cordonnet/Top 
Stitching thread

•  Size #100 Topstitch 
Needle

•  BERNINA® Decorative 
Needle Punch 
Accessory Set

30

Wool Floral 

  Table Topper

This unique decorative item is an updated version of a traditional home 

accent, the wool penny rug. In place of appliquéd circles (pennies), 

needle punched fl owers soften the look, add color and lend an air of 

sophistication to this distinctive home décor project.



triangular shape. Punch the yarn several times until you see the fi bers come 
through on the back. Needle punch the fl owers one more time from the back. 

Create needle-punched blossoms in the same manner on each 
of the black tongues for the edging.

Tip: On a scrap piece of wool, experiment with 

different arrangements of yarn before stitching on 

the actual project.

Assembling the Rug

Using spray adhesive, adhere the black tongues to 
the contrast tongues with bottom edges even; 
the contrast wool should extend about ¼” on 
three sides. 

With Cordonnet thread and #100 topstitch needle, 
blanket stitch around the black tongue, sewing it 
to the contrast wool.

Arrange the 12 tongues evenly around the black 
circle and pin or baste in place with the straight 
edges under the edge of the circle. 

Adhere the black circle with tongues to the contrast circle, 
exactly centering it. Sew in place with the blanket stitch.
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BERNINA® 707 Minimatic (1967-1972)



Supplies
• Purchased Denim Jacket
• OESD Crafter’s Collection #836 

Fish Follies
• Isacord Embroidery Thread 

in desired colors for design 
CC83622

• Yenmet Metallic Thread as 
desired for design CC83622

• Assorted small pieces of fabric 
for appliqué as required for 
design CC83622

• Organ Titanium Embroidery 
Needles

• OESD Bobbin Thread
• OESD Aqua Mesh Plus Stabilizer
• EZ Glitzer (optional)
• Assorted Glitzing stones 

(optional)
• Assorted Beads (optional)
• eXplorations Embroidery 

Software
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Prepare the Templates

Cut out fi sh CC83622 (Penelope) from 
the paper templates packaged with the 
collection. Trace or photocopy the design 
in mirror image. Tip: Use embroidery 
software such as eXplorations to mirror 
image the design and then print a new 
paper template.

Cut a slit along the horizontal and 
vertical lines at the center of each 
template and fold back two opposite 
corners.

Place the paper templates in the desired 
position on the back of the garment. 
Rotate the templates as desired, 

positioning them so that as little of the 
design as possible will stitch over the 
double welt seam. Tip: Organ Titanium 
Coated needles are recommended for 
stitching on denim because of their great 
strength. Titanium needles also help 
keep the adhesive from sticky-backed 
stabilizers from adhering to the needle. 

Using 
chalk, trace 
the lines 
through 
the folded 
back area 
of the 
template. 

 By Kay Lynch Hickman

Nancy Barrett is a talented teacher and 
quilter and is well known for her imaginative 
and often-whimsical appliqué quilts. Her Fish 
Follies designs are truly delightful and can be 
used on more than quilts. The simple bubble 
design on the front of this denim jacket hints 

at the surprise on the back - two fi sh that 
sparkle with personality!



Remove the paper template and extend 
the horizontal and vertical lines. Draw 
an arrow at the top of the design. This 
will be a guideline to help you hoop 
the jacket to ensure that the design is 
stitched in the proper orientation.

Hoop a layer of Aqua Mesh Plus with 
the paper side up. Note: The area of the 
jacket to be embroidered is impossible to 
hoop. Aqua Mesh Plus is a sticky-backed 
water-soluble stabilizer that is designed 
just for this purpose. After the design is 
completed, all traces of the stabilizer will 
be rinsed away. 

Place the hoop template inside the 
hoop. Mark the horizontal and vertical 
centerlines with 
water-soluble 
marking pen on 
the backside of 
the hoop. Use a 
light box or hold 
the hoop up to a 
light if necessary 
to help you see 
the lines.

Use an awl or 
Embroiderer’s 
Wand to score 
just the paper, 
then peel it back, 
revealing the 
sticky surface. 
Note: Re-mark 
lines on the 
sticky surface if 
you cannot see 
through to the back.

Align the vertical and horizontal lines 
marked on the jacket with those marked 
on the stabilizer. (Be sure that the arrow 
marking the top of the design is at the 
top of the hoop.)

Attach the hoop to the machine and 
stitch the appliqué design. Note: Detailed 
instructions for sewing the appliqué 

designs will be included in the packaging, 
but in general, you will use the following 
instructions.

• Stitch the guide stitch. 

• Cut a piece of fabric slightly larger 
than the stitched lines and spray 
the back of the fabric with HRFive. 
Place the fabric right side up over the 
stitched lines.

• Back the machine up, and re-stitch 
the guide stitch.

• Remove the hoop from the 
machine and trim the fabric away 
outside the stitched lines. 

• Return the hoop to the machine 
and continue stitching the design.

Extra Embellishments

The Yenmet metallic thread used in the 
designs add details that sparkle. If you 
wish, add glitz and/or beading to further 
enhance the designs. 

Using the EZ Glitzer, add glitzing stones as 
desired around collar, pockets and cuff. 
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Bubbles
•  Open a New Project in 

eXplorations software.

• Click on the Cookie Cutter mode.

• Open the Shapes folder.

•  Select and drag the circle shape 
onto the workspace.

•  With the shape selected, click on 
one of the outside corners and 
reduce the size to approximately 
.75 inch

•  With the shape selected, click 
on the Stitches Icon and select 
Triple Run stitch.

• Send the design to the machine.

•  Hoop Aqua Mesh Plus Stabilizer 
as in the directions above and 
remove the paper.

•  Adhere the yoke of the jacket 
over the hooped stabilizer and 
attach the hoop to the machine.

•  Stitch the bubble. Continue to 
stitch additional bubbles on the 
front of the jacket by randomly 
moving the position of the 
bubbles, and varying the sizes 
between ½” and 1¼”.

•  Follow the same general 
guidelines, and stitch bubbles 
around the fi shes’ mouths.



Serger Simple 
   Swing Jacket

BY KRISTIE SMITH                                         Defi ne the seams of this 
                                    simple unlined jacket with 
                          fl atlock stitching on luxurious wool 
fabric. So easy to make, it goes together in one – two 
hours! Add freemotion couched embellishments for 
a custom one-of-a-kind look!

Serger Jacket 
Construction
1.  Set the serger for a wide 3-thread 

fl atlock stitch (left needle only). 
Thread the needle and lower 
looper with serger thread and 
use Pearl Crown Rayon in the 
upper looper only.

2.  Cut fabric per pattern 
instructions. Tip: Save 

scraps for testing stitches 

before sewing on actual 

garment. Make any ad-
justments needed to the 
cutting width (it may 
need to be increased 
if wool is thick) and 
to the Micro Thread 
Control, if the serger 
is equipped with this 
feature.

3.  Pin center back to center back with wrong sides together. Tip: 

Pin in the middle of garment pieces, away from the seam. It 

prevents garment pieces from slipping and there is no danger of 

sewing over pins.

4.  Flatlock pieces together, aligning the fabric edge with the 5/8” 
seam guide on the machine. Open the seam by gently tugging; 
seam should lay fl at and be fi nished on both sides. Do the same 
for the other back and connecting front pieces.

5.  Change the serger stitch to a 2-thread overlock wrapped stitch, 
using serger thread in the needle and Pearl Crown Rayon in the 
lower looper only. Serge around the garment front opening and 
lower edge to fi nish all raw edges of the coat.

6.  Add buttons and buttonholes if desired. Embellish coat using the 
Freemotion Couching Foot #43 following the directions below.

Couched Accents
1.  Mark continuous line designs of choice around garment body 

and sleeves with chalk pencil. Creative idea: Use continuous line 

stencils purchased from a quilt shop to guide design.

2.  Attach Freemotion Couching Foot #43 and a new #80 Microtex 
needle to machine. Thread machine with YLI invisible thread in 
upper thread guide and Isacord thread to match garment in bob-
bin case. If using a machine with CB hook, thread the hole on the 
bobbin case fi nger to provide extra tension on the bobbin thread.

3.  Insert cord through guide in foot and lower the feed dog on the 
machine. Position garment under foot to start. Start by stitch-
ing in place about 
4 times to secure 
cord. Move fabric to 
free-motion stitch the 
cord, following the 
chalk lines on gar-
ment. End by stitch-
ing in place about 4 
times to secure end 
of cord.

Supplies
•  Indygo Junction Simple Swing 

Jacket pattern IJ700 
• 2 spools of serger thread

•  1 spool of YLI Pearl Crown 
Rayon thread 

•  Wool or wool blend fabric 
yardage as specifi ed per 
pattern

•  Freemotion Couching 
Foot #43

• YLI Invisible Thread
•  OESD Isacord thread to 

match garment

• Chalk pencil
• Decorative cord 
• #80 Microtex needle
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Stitch Settings 
Wide 3-thread Flatlock Stitch

• Left needle – all-purpose thread – tension 1.5
• Upper looper – Pearl Crown Rayon thread, tension 4.0
• Lower looper – all-purpose thread – tension 8
• Cutting width*: 1-3
• Stitch length: 2.5
*Note: If working with a BERNINA serger with mtc (Micro Thread 

Control), adjust the mtc knob to its widest setting. This will build 

more “wiggle room” into the stitch formation and create an 

extra-wide fl atlock.

2-thread Wrapped Stitch

• Left needle – all-purpose thread – tension 5.0 
• Lower looper – Pearl Crown Rayon thread – tension 3.5
• Upper looper converter installed
• Cutting width: 1-3
• Stitch length: 2.5

Tips for using Freemotion 
  Couching Foot #43:
-  Foot #43 is designed for use with smooth, fl exible cords 

approximately 2mm in diameter, such as macramé cord. 
Take the foot with you to the store when shopping for cords 
to ensure the cord fl ows freely through opening. 

-  Practice free-motion stitching with chosen cords on scraps 
of fabric before stitching on the garment to make sure you 
are pleased with design.

-  Free-motion stitching with Foot #43 is smoother if the 
motor speed is faster than the movement of your hands.

-  Foot #43 has a clear, cupped sole that easily glides over 
seams and provides visual access to follow cording as you 
are stitching.

-  Foot #43 is designed to be used with a straight stitch in the 
center needle position.

Creative License
Use fl eece instead of wool, adjusting the diff erential feed of the serger if needed. It enables you to control the speed of the feed dog 
and prevents or promotes stretching of fabrics. Try it both ways; you may want a rippled edge around the outside of the coat.

New From BERNINA®!
Double Cording Feet #59C and #60C
 •  Use with all BERNINA® models – maximum 5.5mm 

and 9mm stitch widths 

 • Create single or double corded piping with little effort

 •  Couch a single or double row of decorative cords with 
one pass

 •  Double tunnel on the sole of the foot holds cording 
or piping in place for stitching

 •  Use Double Cord Foot #59C when 
               working with 4mm to 6mm 

                            wide cords

     •  Use Double Cord Foot 
#60C when working 
with 7mm to 8mm 
wide cords
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Add a touch of elegance to this fragrant sachet 
using the new BERNINA® Exclusive design 
collection by Elly Sienkiewicz. Select any of 
her Baltimore Elegance designs to adorn the 
front of this simple linen project.

Instructions
Hoop stabilizer (paper side up) in the Large Oval Hoop. Peel back the 
paper to reveal the adhesive. Center one linen square in the hoop and 
smooth it in place.

Embroider Design #14 using the following Isacord Colors: Color #1: 0345, 
Color #2: 1912.

Remove stabilizer from fabric. Using a fabric marker, mark a square on the 
embroidered fabric about 1” away from the design on all sides.

Sew the muslin squares together and fi ll with lavender.

Place the muslin sachet between the marked embroidered square and the 
         backing square; pin to secure. Select a heirloom 

stitch such as a pinstitch, star, or daisy stitch. Using 
a Wing Needle and fi ne embroidery thread, sew on 
drawn line. 

Note: The back and front edges are fi nished differ-
ently as directed below.
Trim away the excess fabric from the back, cutting 
close to the stitching. 

On the front, trim fabric 1” beyond the sewn line. 
Fringe the top fabric.

Baltimore 
 Sachet

BY BARBARA ALENCI

Supplies
• Two 9” squares of linen
•  White 60wt fi ne 

embroidery thread
• Size 100/16 Wing needle
•  Aqua Mesh Plus 

stabilizer
•  Isacord embroidery 

thread (see Instructions 
for specifi c colors)

•  Water-soluble fabric 
marker

•  BERNINA® Exclusive 
Design Collection: 
Baltimore Elegance 
by Elly Sienkiewicz

•  2 small squares of 
muslin

• Dried lavender 

Winging It!
Wing needles get their 
name from the fl at 
wedge of metal, resem-
bling a wing, on each 
side. Used for and 
heirloom sewing, this 
needle makes holes in 
fabric. Natural fi bers 
such as linen and ba-
tiste work best with wing needles because the fi bers 
will remain pushed out of place to form the decora-
tive holes. Multi-motion stitches that return to the same 
holes several times are the best choice for this decora-
tive technique as they make the holes more prominent 
and the thread embroiders the edges of the holes as the 
needle moves in and out of them.

Get this design FREE!
www.berninausa.com > What’s New > Free Downloads > Free BERNINA Project 
Embroidery Designs > Baltimore Elegance
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